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Phenology  noun  phe·nol·o·gy |  \ fi-ˈnä-lə-jē   

 
1: a branch of science dealing with the relations between climate and 
periodic biological phenomena (such as bird migration or plant flowering) 
 
2: periodic biological phenomena that are correlated with climatic 
conditions 
 

The study of nature’s calendar 
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INTRODUCTION 
 

The Yellowstone Phenology Project is a citizen science initiative designed to monitor 
environmental change over time across a 5,000’ elevation gradient in Yellowstone National 
Park. The project contributes additional monitoring elements to baseline data gathered at 
seven sites from Gardiner Basin to the top of Mt. Washburn (Figure 1).  
 

 
 
 
These sites were originally established in 2008 by the park’s physical scientist, Dr. Ann Rodman, 
to monitor pollinator diversity and abundance. Since its inception, remote sensing equipment 
has been added to these climate change monitoring plots. The Yellowstone Phenology Project 
has established ten invertebrate pitfall traps and three plant transects at all seven climate 
change sites.  
 
Located in the middle of this elevation gradient, the National Science Foundation’s NEON 
(National Ecological Observatory Network) site completed construction in 2018. The NEON site 
in Yellowstone is one of 81 locations across the United States (Figure 2) that utilizes 
sophisticated methodologies to monitor 32 environmental conditions, including documenting 
carabid beetle diversity. The Yellowstone Phenology Project extends the NEON dataset to cover 
a wider elevation gradient by replicating the NEON carabid beetle field protocols.                                                                                                                             
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Carabids, collected with pitfall 
traps (Figure 3), are a well-
documented family of ground 
beetles that may serve as an 
indicator of environmental health 
and change. Carabid samples will 
supplement Yellowstone’s beetle 
catalog housed at the Heritage 
and Research Center. Other 

invertebrate samples contained in 
the pitfall traps will be available to 

collaborating institutions for further research. Many new park species and range extensions are 
expected to result from this work. Data derived from orthoptera (grasshopper) diversity and 
abundance samples will also contribute to Home on the Range research objectives.  
 
Plant phenology transects are located at each of the three points associated with the seven 
climate change sites. Citizen scientists identify plants falling along these transects and 
document phenophases including first flower, first fruit/seed, and brown out. The timing of 
these events is correlated with environmental changes.  
 

Figure 2.  NSF’s National Ecological Observatory Network 

Figure 3.  Pitfall trap. 
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Yellowstone National Park has developed strategic priorities with key focus areas that can be 
sequenced, funded and implemented.  These priorities serve as a guide and citizen science 
volunteers help achieve them as follows: 
 

1) Focusing on the Core – Improve strategic management and business acumen; improve 
organizational alignment and effectiveness.  Citizen science volunteers with proper 
training contribute to cost effective workforce performance.  Pilot projects in 2018 
contributed in-kind support and cash donations equaling $51, 678.  Over 2000 
volunteers were engaged with a 100% safety success rate.  When volunteers participate 
in field and lab work, operational workloads are managed more efficiently. 

2) Strengthening Ecosystem and Heritage Resources – Advance and sustain the 
Yellowstone Ecosystem; promote and protect Yellowstone’s cultural heritage.  The 
Phenology project contributes directly to Yellowstone’s climate monitoring effort.  The 
volunteers document wildlife and vegetation resource conditions at a fine scale to 
inform landscape level management decisions.  This effort was developed through 
collaboration with NEON, and has since fostered cooperative research with Montana 
State University, Colorado State University, the University of Nebraska and the USDA 
(office of Plant Protection and Quarantine).  Data generated will provide critical 
information for focal species (ungulates and sage habitat) as well as inform larger trends 
that may be incorporated into climate adaptation response planning. 

3) Delivering a World Class Visitor Experience – Understand and respond to increased 
visitor use; connect people to Yellowstone.  Having a cadre of trained volunteers allows 
for more flexibility to supplement staffing needs.  Volunteers make excellent program 
ambassadors to explain project objectives and recruit new volunteers.  40% of the 2019 
Phenology project’s 29 volunteers were recruited by 2018 participants.  Local and 
regional residents have often moved here to enjoy the GYE and are highly motivated to 
“give something back” to the park. Hands-on stewardship programs offer powerful 
kinesthetic learning experiences and program participants enjoy “dive deep” learning 
about park resources like plant ecology, invasive species impacts, ungulate guild 
dynamics, raptor population trends, invertebrate taxonomy, museum curation, and 
database management. These deep connections foster a better understanding for 
resource management complexities and give a tangible sense “doing something real” to 
benefit the park by following rigorous scientific protocols to collect useable specimens 
and data. Participants become well-informed resource stewards and park advocates.  
Participants return to the park many times throughout the season, building a 
community of practice by making personal connections to YF, YCR staff, and each other.  

4) Building Coalitions and Partnerships – Strengthen Yellowstone Forever and 
Philanthropic Capacity; Build Trust with Gateway Communities; Strengthen 
Conservation, Environmental, Economic, and Recreation Partnerships.  YCR staff 
prioritizes program needs that may benefit from citizen science, and YF assists with 
recruiting, training, and working in the field with volunteers (Figure 4).  YF added citizen 
science to its strategic priorities in 2018 and hired a full-time program manager.  Citizen 
science collaboration has made significant contributions to strengthening partnerships 
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between YCR and YF.  Gardiner, Livingston, Bozeman, Billings, and several Native 
American communities have contributed to Yellowstone Citizen Science. 

 
 

 
 

 
 
 
Yellowstone Forever Phenology Project home page: 
 
https://www.yellowstone.org/experience/citizen-science/phenology-project/ 
 
 

 
 
 
 
 

Figure 4.  2019 Citizen science volunteers and Park staff. 

https://www.yellowstone.org/experience/citizen-science/phenology-project/
https://www.yellowstone.org/experience/citizen-science/phenology-project/
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SCHEDULE OF WORK 2020 
 

Pitfall traps will be checked, emptied, and reset and plant transects will be read every 14 days 
so that the samples from each bout are directly comparable. The sampling will occur 
consistently every 2 weeks for the entire field season, on the same day of the week, and at 
roughly the same time of day as follows:   
 
April 10, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no housing) 
April 24, shared cabin housing available in Gardiner, MT, check in 4-8pm,  
April 25, shared cabin housing available in Gardiner, MT, check out by 9am, April 26 
 
May 8, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no housing) 
May 22, shared cabin housing available in Gardiner, MT, check in 4-8pm 
May 23, shared cabin housing available in Gardiner, MT, check out by 9am, May 24 
 
June 5, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no housing) 
June 20, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm, shared cabin housing 
available in Gardiner, MT, check in 4-8pm, check out by 9am, June 21 
 
July 3, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no housing) 
July 18, shared cabin housing available in Gardiner, MT, check in 4-8pm, check out by 9am, July 
19 
July 31, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no housing) 
 
August 14, shared cabin housing available in Gardiner, MT, check in 4-8pm 
August 15, shared cabin housing available in Gardiner, MT, check out by 9am, August 16 
August 28, day trip, meet @ YF Bookstore in Gardiner, MT @ 8:00am, finish by 4pm (no 
housing) 
 
September 11, shared cabin housing available in Gardiner, MT, check in 4-8pm 
September 12, shared cabin housing available in Gardiner, MT, check out by 9am, September 
13 
September 25, day trip, meet @ YF Bookstore in Gardiner, MT @ 9am, finish by 4pm (no 
housing) 
 
October 9, shared cabin housing available in Gardiner, MT, check in 4-8pm 
October 10, shared cabin housing available in Gardiner, MT, check out by 9am, October 11 
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PROTOCOLS 
 

NAVIGATING TO THE SITE  
 
Use Yellowstone Forever’s Samsung tablets to navigate to the YNP Phenology Project sites, 
using the Collector app. To collect data, use the Survey123 app. 

 
Using Collector to Locate Phenology Project Sample Sites 

1. Power the tablet on by pushing the external button on the upper right edge of the tablet. 

2. From the home screen locate and open the Phenology folder.  

 
 
 
 
 
 
 
 
 

 

 

3. The next screen will show icons for three apps: Survey 123, 

Collector and Memos. Use the Collector app to navigate to 

sites;  Use Survey 123 to collect site data. 

Memo app is a place to take notes and save them on the 

tablet.  

 

4. Tap the Collector app icon to open it. 
 
 
 
 

5. The screen that appears 

shows the maps that are 

stored on this device. Tap 

on the YNP Phenology 

Project Locator Map. 
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6. A map will open showing imagery 
of YNP with several colored dots. 
The blue dot represents your 
present location and will move with 
you even if your device is not 
connected to a signal. If the blue 
dot is grey go to an open canopy 
area to get a satellite location fix. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

7. If you tap the three vertical squares 

in the upper right side of the screen a drop 

down will appear, tap Basemap. 
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8. The screen that appears will show your basemap options. Yell_NAIP is satellite imagery 

and Yell_Topo is a topographic map. Toggle between these for the background you prefer 

at any time. For driving to the site use Yell_Topo to see roads and other land marks. For 

locating the sample sites use Yell_NAIP. Tap map to select. 

 
 

9. The icon below is the bookmarks icon. Tapping this will show a list of our sampling 

locations which will zoom your map to your area of interest. 
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10. Once zoomed in to your area of interest, you 

will see a cluster of dots. Tapping on the three vertical 

dots on the upper right will bring up the drop down 

menu you saw before. This time tap on Layers. 

 

 

 

 

 

 

 

 

11. Touch either a red circle pitfall icon, or a yellow 

circle plant transect icon and follow your blue dot 

until you arrive. Once you are close, put the tablet 

down and look around for the white square pitfall - 

it is now time for you to conduct your sampling and 

switch to viewing the Survey 123 app. When you 

are ready to resume navigation to your next site 

return to Collector for help locating it. 

 
 
 
 
 
 

 
 
 
12. If you do not record anything in the comments field and you only use this map for 

locating your sites, you are done. However, if you did record comments then you need to 

push those edits back to “the cloud” once you are able to reconnect the tablet to a wifi or 

LTE network via a mobile hot spot.  See the Synching Collector section for more instructions. 
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PITFALL SERVICING 
 
Phase One: Preparation 
 
1. Checklist the "Kit" before leaving the classroom.   

Resupply as needed.  Make sure Tablet is fully charged.  
Some supplies will need to be carried in back packs. 
They won’t all fit in the tool tray (Figure 5). 

 
2. Drive to the site area, park in a safe spot and walk to 

the collection site carrying the kit.  You can use the 
“collector” app, select Basemaps, and then 
YELL_Topo_Current to navigate to the site both driving 
and hiking.  Be aware of your surroundings, keeping a 
watchful eye on the bison, elk, deer, or other wildlife.  
Stay back 25 yards. 

 
3. Using the Tablet, navigate to the collection site.  

 
4. Approach the site from the side while avoiding areas 

marked with yellow/blue circles on the map (Figure 
6). These are the “core” climate monitoring areas we 
need to avoid walking through. Sound recorders are 
active – be mindful. 

 
5. The writing on the white cover plate (Figure 7) is on 

the side toward the center rebar. As you approach 
from the outside, the writing on the cover plate 

should be away from you.  
Approaching from the outside 
minimizes vegetation trampling. 
 

 
 
 

 

 
6. Set kneeler down on ground behind cover plate by 

approximately 1.5 feet (Figure 8). The Primary 
person kneels onto pad. The Secondary person stays 
behind the Primary and acts as an assistant. 

 

Figure 5.  Carrying supplies in 
the field. 

Figure 8.  Kneeler and cover 
plate. 

Figure 7.  Cover plate. 

Figure 6.  Approach the site from 
the side. 
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Phase Two:  Collecting the Pitfall Sample 
 
The priority of the following procedure is to secure the 
specimen packet into the gallon Ziploc.  Once the insect 
packet is secure, you can then reset the pitfall trap and 
tidy up the area. 
 
1. Prep wash bottle with filter fabric. 
 
2. Pull out the labels sheet. Find and confirm a strip of 
labels matching the site location (i.e. MAMM) and 
pitfall code (i.e. 1S) match what is written on the 
plastic cover plate. Cut a strip of 3 labels (Figure 9) and 
hold aside by putting labels into a shirt pocket.  
Protect labels from flying away. 

 
3. Pull out a whirl pack and spread it open.  Blow into it to open it up completely. 
 
4. Place two clean empty deli cups in front of you, one 
to the left and one to the right. 
 
5. Put on a pair of skin protecting gloves. The clay in 
the dirt is very drying. 
 
6. Remove 3 of the 4 stakes. Lift and carefully swing 
plate and wire grid, together as one unit, toward 
downhill side so plate does not bump into slope 
(Figure 10). Avoid knocking dirt into the pitfall cup. 
 
7. Carefully lift out collection cup filled with glycol, 
insects and labels. Leave the second deli cup with 
drainage holes in the ground. Clean out dirt and 
rocks from drain cup. 
 
8. Set the specimen collection cup between the two clean   
deli cups. 
 
9. Fish out the labels from the specimen cup (Figure 11). 
Rinse them with water over the right-side deli cup. 
 

Figure 9.  Cutting labels. 

Figure 10.  Swing cover plate to the 
downhill side. 

Figure 11.  Remove labels. 
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10. Place the wet labels (text facing out) inside the whirl pack and set aside. Strain the 
insect specimen and glycol through the fabric into the deli cup on the left side. Set this 
cup with strained glycol aside to the left. This cup of strained glycol will be reused later 
when resetting the trap. Catch the rinse water into the deli cup on the right side. 
Inspect the cup for any straggler insects, rinse again, strain through fabric, catch liquid 
into the cup on the right side (Figure 12).  Try to be conservative with rinse water 
because this strained water gets poured into the “Glycol Discard” bottle which needs 
to have enough room to service 10 sites. 

11. Holding on from the bottom of the bottle, gently clasp the filter fabric while 
unscrewing the ring from wash bottle. Barely pull the wash bottle away from the ring.  The 
bottle, fabric and rings should all be in close contact while you rinse the neck of the bottle of 
any straggler insects.  Inspect bottle to ensure all specimens have washed into filter fabric. 
 
12.  Gently remove wash bottle and ring and set aside. You should now be holding only the 
filter fabric filled with insects. 
 
13.  Gather the four corners of the 
fabric together (Figure 13). Twist 
the four corners together. Do not 
squish the insects! This will leave 
open gaps in the fabric pouch and 
that is just fine. 
 
14.  Secure the fabric with a small 
binder clip (Figure 13). 
 
15.  Place the insect packet in a 
whirl pack. Blow into the whirl 
pack forcing the insect packet to 
the bottom. 

Figure 12.  Strain and rinse specimen, catching glycol and rinse water in deli cups. 

Figure 13.  Insect specimen in filter fabric, held by four 
corners and secured with binder clip. 
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16.  Ensure the out-facing labels and the insect packet are 
both securely at the bottom of the whirl pack. Squirt ethanol 
into the pack so the insect packet and labels are covered 
using about 1.5"-2.0" of ethanol (Figure 14). 
 
17.  Place whirl pack against your thigh, press pack flat to 
push air out. 
 
18.  Grab metal twist ends and flip or whirl the pack to seal 
in contents (Figure 15).  Twist the metal ties together. 
 
19.  Place the whirl pack with insect packet and labels into 
the large gallon Ziploc bag (Figure 16). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14.  Add ethanol. 

Figure 16.  Ziploc bag with whirl packs. Figure 15.  Ensure labels are visible, whirl the bag, 
and seal contents. 
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Phase Three: Reset the Trap and Tidy Up 
 
1. Pour the rinse water collected in the right-side deli cup into the Glycol Discard bottle. 
Reseal the bottle and set in carrying tray. Wipe out the deli cup and set in tray. 
 
2. Place a strip of three site matching new (current date forward) labels into the strained 
glycol cup. 
 
3. Make sure the labels are deep in the liquid, either plastered onto the side or on the 
bottom.  
 
4. Top off the glycol if necessary so cup is about a 
third full. Fill to the bottom line etched onto cup. 
 
5. Clean out the drainage cup. 
 
6. Place the strained glycol cup back into the base 
cup and press into place (Figure 17). Inspect the 
outer edges of the glycol cup. The surrounding dirt 
needs to be pressed flush to the edge of the rim. 
 
7. Carefully swing metal grid and plastic cover back 
into place. The metal grid is to help keep larger 
animals from falling into the cup. 
 

 8. The metal grid should lightly rest on the dirt 
while the plastic cover hovers above it. Reset pvc spacers if needed to keep trap lid above 
ground level.  

 
 9. Reinsert the stakes into original holes (if possible). 
 
 10. Leave about an inch of stake showing above the plastic cover. Tidy up your supplies 

making sure all bottle caps are secured and tools are returned to the kit. 
 
 11. Stand up and fold up kneeler, back out of the pitfall site, open Tablet and answer 

questions regarding the collection site, using the Survey 123 app. (Detailed instructions for 
Survey 123 app use in next section.) 
 
Navigate to next site. 
 
For additional details and to see the protocol demonstrated, a video tutorial of the pitfall 
servicing protocol is available at 
 
https://youtu.be/XDsiTtf2qjY 

Figure 17.  Replace glycol cup with 
new labels into base cup. 

https://youtu.be/XDsiTtf2qjY
https://youtu.be/XDsiTtf2qjY


 
 
 

19 

USING SURVEY 123 TO RECORD PITFALL OBSERVATION DATA 
 
1. Press the home button on your tablet (the oval button in the bottom 
center of your device) to escape Collector.  On the home screen locate the 
Phenology folder as you previously did, open it, but this time tap the Survey 
123 icon.   
 
2. Allow the app to load; this will take a few seconds.  Once loaded you will see a screen 
titled “My Surveys”; tap the YNP Phenology Project Survey icon. 

 
 
 
 
 
 
 
 

 
 
 
 
3. Tap on the “Collect” icon at the left bottom 
of the new screen that is launched.  This will load 
the survey.  
 
 
 
 
 
 
 
 
 
 
4.  Respond to the questions asked for each pitfall site that you visit by either tapping the 
radio buttons or typing the information requested. Responses to all questions are required 
except for the last question requesting comment; this is optional. When you have completed 
the survey tap the check mark in the lower right-hand corner. This will launch a screen that says 
that the survey is completed and has been saved in the outbox.  Screenshots of the survey 
questions: 
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5. Tap the OK button.  If you need to return to the Collector App to locate your next 
sample site, press the home button and navigate back to Collector. Once you have located your 
next sample site repeat the above steps to fill out a new survey for your next pitfall sample. 
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READING PLANT PHENOLOGY TRANSECTS 

 
Plant Observation Protocol 
 
This protocol is repeated three times at each site. 1-2 person teams are used to read plant 
transects. If two people are available, one reads the transect, the other captures observation 
data on the tablet using Survey 123. See user guide. Otherwise one person must read transect 
and enter observations. 
 
1. Locate the yellow rebar center stake, 1 Center, 2 Center, or 3 
Center (Figure 18).  
 
2. Next locate the yellow and blue rebar transect end stake, 16 
meters away (Figure 19). This stake will always point towards the core 
(do not enter) climate monitoring plot, in between cardinal directions, 
i.e. NE, SW, etc.  

 
 
 
 
 
 
 
 
 

 
 
 
 

 
 
 
3. The plot reader slides the metal tab end 
of the measuring tape over the top of the yellow 
rebar center stake down to the ground, walks 
towards the yellow/ blue stake, keeping to the 
left of the tape as it unspools (Figure 20), and 
wraps the tape three times around the base of 
the yellow/blue stake. Try to make as straight a 
line as possible. Weave tape under shrubs 
down to the ground as needed.  
 
 
 

Figure 18.  Yellow 
rebar stake. 

Figure 19.  Blue rebar stake. 

Figure 20.  Plot reader walking towards 
blue stake, keeping tape straight and close 
to the ground. 
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4. Return to center stake, avoiding the “read on right” side of the tape.   
 
5. Take out the Daubenmire, go to meter 
mark 5, center the frame on the 5m mark, 
perpendicular to the tape, (short axis of frame 
touching tape) (Figure 21). 
 
 
6. Using kneelers, closely examine all 
plants with stems in frame. Ask data entry 
team member to read the dropdown species 
list, and use plant guide to ID plant species 
present and phenophase (i.e. sticky geranium, 
full flower) (Figure 22).  Record data in Survey 
123. 
 

 
 
 

7. Repeat 10 times at every meter mark (5m-14m).  
 
8. Unwrap tape, walk back, avoiding the “read on right” side of the tape, secure all gear.  
 
9. Navigate to the next center stake.  
 
For additional details and to see the protocol demonstrated, a video tutorial of the plant survey 
protocol is available at: 
 
https://youtu.be/g6L21ZyUDts 
 

Figure 21.  Place frame along the tape. 

Figure 22.  Use plant guide to identify species and phenophase. 

https://youtu.be/g6L21ZyUDts
https://youtu.be/g6L21ZyUDts
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Using Survey 123 to Record Plant Data 
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PLANT IDENTIFICATION 
 

Arrowleaf Balsamroot, Balsamorhiza sagittate, Native 



 
 
 

30 

Cheatgrass, Bromus tectorum, Invasive



 
 
 

31 

Common Dandelion, Taraxacum officinale, Non-native, 
 naturalized 

 



 
 
 

32 

Cous Biscuitroot, Lomatium cous, Native



 
 
 

33 

Desert Alyssum, Alyssum desertorum, Non-native



 
 
 

34 

Field Chickweed, Cerastium arvense, Native 



 
 
 

35 

Fringed Sage, Artemesia frigida, Native 



 
 
 

36 

Hood’s Phlox, Phlox hoodii, Native



 
 
 

37 

Lupine spp., Lupinus spp., Native



 
 
 

38 

Musk Thistle, Carduus nutans, Invasive



 
 
 

39 

Plains Pricklypear, Opuntia polycantha, Native



 
 
 

40 

Prairie Smoke, Geum triflorum, Native



 
 
 

41 

Pussytoes spp., Antennaria spp., Native



 
 
 

42 

Sagebrush Buttercup, Ranunculus glaberrimus, Native



 
 
 

43 

Spearleaf Stonecrop, Sedum lanceolatum, Native



 
 
 

44 

Sticky Geranium, Geranium viscosissimum, Native



 
 
 

45 

Sulphur Buckwheat, Eriogonum umbellatum, Native



 
 
 

46 

Wild Parsley, Musineon divaricatum, Native



 
 
 

47 

Yarrow, Achillea millefolium, Native



 
 
 

48 

Yellow Salsify, Tragopogon dubius, Native 
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SYNCHING SURVEY 123 
 
1.  Now that you have collected your data in the field, it is time to push that information to 
the cloud where we can connect to it within the YNP computer network.  In order to perform a 
sync with the cloud you need to connect your tablet to a wifi network or to the LTE network via 
a mobile hot spot.  The procedure for how to do this will depend on the network where you are 
connecting to. If you are connecting at the YCR office, please get the assistance of one of our 
staff to connect to a mobile hotspot, as we do not have public wifi at the NPS. If you are 
connecting at Yellowstone Forever, ask for assistance for a Yellowstone Forever staff member 
with connecting to their guest wifi network. You can also use your personal LTE connected 
device as a mobile hotspot. However, it is not recommended because it will use up a lot of your 
data. Once your tablet is connected to a network, open Survey 123 again. 
 

2. Tap on the Outbox icon at the bottom left of the Survey 123 screen. 
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3. Tap the send button at the lower 
right of the new screen.  If you are 
connected to the internet and you do not 
see the send button, your tablet may need to 
update its position. If you are inside, go to a 
window or take it outside so the onboard 
GPS can update. Once your position is 
established the send button will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. This will send your survey results to 
the cloud.  You will know that your data has 
been sent because the Outbox will turn from 
blue to grey and will say “Sent”.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. Congratulations you are finished, 
unless you made comments in the YNP 
Phenology Project Locator Map.  You can 
now power off your tablet and plug it in to 
recharge. 
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6. If You made comments in the YNP Phenology 
Project Locator Map you will need to sync your map to 
the cloud. This process is very similar to the process of 
synching Survey123 only now you will do it in Collector. 
To perform a sync you need to connect your tablet to a 
wifi or LTE network, ask YNP or YF staff for help 
connecting your tablet to the internet. From the home 
screen of your tablet open the Collector App. If Collector 
opens to the map you need to tap the back arrow on the 
upper left corner to take you back to the All Maps page.  
 
 
 
 
 
 
 
 
 
 
 
 

7. If your device is connected to the internet you will see the word Sync below and right 

of your map title. Tapping this button will send your changes to the cloud. A time bar will start 

scrolling on your map and when it is complete it reports the date and time of your sync.  

 

 

 

8. Congratulations you are now done and can safely power down you tablet and plug it 

in to recharge. 
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ORDER LEVEL INSECT IDENTIFICATION 
 

In general, sorting of bycatch should happen throughout the field 
season as samples are collected, so that the first stage of sample 
processing is completed prior to the end of the field season. 
Identification, pinning, and pooling of carabids occurs at the end of the 
season when the majority of species have been collected. Although 
these activities may occur several months after sample collection, all 
beetle processing must be completed within four months of the end of 
the field season.  
 
First, an introduction.  Insects are the most dominant group of animals, and the Earth’s most 
varied organism.  80% of all known animals are insects, and they comprise 57% of all life on 
Earth.  There are more than one million described species (only 54K vertebrates). 
 

View macrophotography images of Yellowstone insects here: 
https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434 

https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434
https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434
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A bit of insect anatomy… 

 
  
 

The pronotum is a 
prominent plate-like 
structure that covers all or 
part of the thorax of some 
insects. 
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Head/Mouthparts 

Wings and wing modifications 

 
 
 
 
 
 
 
 

a.  Herbivore – chewing 
b.  Carnivore – slicing 
c.  Herbivore - sucking 

Piercing/sucking 

Coiled 

Sponging-sucking 

Generalized, membraneous 
(dragonfly) 

Elytra (beetle) Hemiptera (true bug) 

Halteres (true flies) 



 
 
 

55 

Coleoptera 

Podcast on the “Tigers of 
Yellowstone”: 
https://go.nps.gov/tigersofyellowstone 
 

Beetles vary in length from 0.25 mm to 150 mm and include the largest insects by biomass 
known.  They are characterized by having chewing mouthparts, large compound eyes and 
usually possessing thickened forewings (elytra) which meet at the midline when folded.  Their 
membraneous hind wings fold up under the elytra when not in use, permitting them to inhabit 
rugged environments without endangering their flight capability.  Antennae are highly variable. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Membraneous hind wing Elytra (fore wing) 

Chewing mouth parts 

Tiger beetle.  Label and 
place in a separate vial. 

https://go.nps.gov/tigersofyellowstone
https://go.nps.gov/tigersofyellowstone


 
 
 

56 

Coleoptera – Carabidae 
 
In our work, Carabid beetles are separated from other 
Coleoptera because they are a target Family for the 
Phenology project.  In 2018 alone, 3,620 Carabids were 
collected, including 55 different species (one, a new Wyoming state record, pending 
confirmation).  Five species comprise 54% of the Carabids collected, with species abundance 
and composition varying throughout the field season. 
 
The most notable characteristics in Carabid identification are the notopleural suture and the 
offset trochanter.  Also look for tactile setae over the eye and pronotum. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Carabid beetle diversity 
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Orthoptera (Grasshoppers, Crickets, and Katydids) 
 
Orthoptera generally have modified hind legs for jumping and thickened fore wings called 
tegmina.  Their name comes from the Greek “orthos” meaning straight, and “pteros” meaning 
wing.              Some may have an ovipositor at the hind end.  
 
 
Hemiptera 
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Hemiptera (Bugs, Hoppers, Aphids, Scales, Whiteflies, Cicadas) 
 
Hemiptera, the “half-wings”, have piercing, sucking mouthparts.   

 
 
There is a huge diversity in this Order with respect to body form, wings, and 
antennae.  They are predators, herbivores, and parasites; some may be 
vectors.  Their fore wings cover the hind wings and often form an “x” when 
viewed from above. 
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Hymenoptera (Bees, Wasps, Ants, Sawflies) 
 
The Hymenoptera are so named because of the Greek “hymen” + “ptero” 
meaning “membrane wing”.  Also, for “Hymen”, the Greek god of 
marriage, because the fore wings and hind wings are joined together with 
small hooks called hamuli.  They have chewing mouthparts, four 
membranous wings, and their waist is often constricted. 
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Diptera (Flies, Midges, Mosquitos) 
 

Diptera, meaning “two wings”, have modified hind wings 
(halteres).  They have a great diversity of natural history strategies 
and many are pests and vectors of disease.  There are a variety of 
mouth types, from sponge-sucking to skin-piercing. 
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Acari (Mites) 
 
Mites are related to spiders and scorpions, having 
eight legs.  They have two body sections, the 
prosoma and opisthosoma, but often appear to 
have only one body section.  They lack a separate 
head structure and leg length is highly variable. 
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Spiders  
 
Spiders are characterized by possessing pedipalpi   
 
and chelicerae,  
 
lacking antennae, and having four pairs of legs and a 
cephalothorax and abdomen.   
 
Chelicerae are believed to be appendages of the third body 
segment, usually modified into predatory organs.  Pedipalpi 
are sensory structures that form the base of a preoral cavity 
in which the chelicerae function. 
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Collembola (Springtails, Snow Fleas) 
 
Collembola are the most abundant hexapods on Earth and the earliest fossils are 
over 400 million years old.  They are mostly tiny litter and soil inhabitants.  A few 
are crop pests.  They have a ventral tube, four-segmented antennae, and six or 
fewer abdominal segments.  The most distinguishing characteristic to look for is 
their jumping organ, the furcula. 

 
 
Neanurid sprigtails are poorly known in most areas of the U.S.  Some 
even lack eyes.  
 
 
 
 
 
 
 
 
 
 

Entomobrya quadrilineata

Furcula

Ventral tube

Four antennal segments
I

II
III

V
I

IIIIIIV
VI

Quick morphology lesson….

Three thoracic segments, 
six abdominal segments
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Millipedes and Centipedes 
 
Both millipedes and centipedes have segmented bodies with many 
legs.  Millipedes are somewhat cylindrical and have two pairs of legs 
per segment,  
 
while centipedes are flat and have one pair of legs per body 
segment.   
 
Millipedes move slowly and burrow, while centipedes are known for 
their speed.  Millipedes are primarily detritivores; centipedes are 
carnivorous and kill their prey by injecting them with venom.  
Centipedes sometimes bite humans, but it is rare that their venom 
will produce a severe reaction.   
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Non-Target groups (DISCARD) 
 
Pseudo scorpion     Earwigs 

Thrips                Silverfish 

 
Moths and Butterflies (scaled wings) 
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Unusual Observations 
 
Make a separate vial and label for any unusual specimens. 
 

 
 
 
 
 
 
Tiger beetles – label and save in 
separate vial 
 
 
 
 
 

 
 
 
 
 
 
Parasitic 

eggs 
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INSECT SORTING PROTOCOL 
 
1. Remove labels from whirl pak, attach clean filter fabric to 
funnel, dump sample into funnel, rinse whirl pak and label into 
funnel. 
 
2. Submerge funnel contents in bowl of water to float 
specimens above soil, gravel. Skim samples off surface and 
place into sorting tray or petri dish. 
 
3. Remove filter fabric from funnel, rinse residual sample onto 
filter fabric, set aside on petri dish to dry. 
 
4. Dry and cut labels, create one Carabid label for every whirl 
pak, write Carabid on back of label, place in a 4 dram vial. 
Repeat for every whirl pak. Use extra labels for other orders as 
you find them. Write with archival pen on back as: Mites, 
Carabid, NC Coleo, Coll, Dip, Milli/Centi, Hemip, Hym, Orthop, 
Spiders.   
 
5. All specimens except Carabids from each collection event are pooled together into one vial. 
One collection event has 10 whirl paks, one from each pitfall trap. All ten whirl paks should 
have labels with the same collection date range, but will have unique pitfall codes. (1S, 2E, etc.) 
indicating where the Carabids came from. This means for each collection event you will have 
one vial per Order, and up to 10 vials for Carabids. This is the most important part of our 
Carabid research. 
 
6. Wet sample with ethanol, remove large specimens with forceps, sort into Order-level vials or 
tubes. 
 
7. Use a brush to remove soft-bodied or small specimens such as springtails and mites.  
 
8. Shift filter fabric under scope to look for residual specimens, repeat steps 
4-5. 
 
9. Flatten, dry, and return undamaged whirl paks and filter fabrics. Trim 
frayed fabric fibers, discard whirl paks with separating twist wires or leaks. 
 
10. Pin the Carabids.  Please refer to these training videos for pinning protocols: 
Card (0-6’) and point (6’-10’) mounting: https://www.youtube.com/watch?v=ORP5WK5AVqs 
How to Pin a Beetle: https://www.youtube.com/watch?v=kMYeWN7mN_w 

 

11. Return pinned Carabids, vials, whirl paks, and filter fabrics to bug hub or Erik Oberg. 

https://www.youtube.com/watch?v=ORP5WK5AVqs
https://www.youtube.com/watch?v=ORP5WK5AVqs
https://www.youtube.com/watch?v=kMYeWN7mN_w
https://www.youtube.com/watch?v=kMYeWN7mN_w
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PHOTOGRAPHY 

 
MACROPHOTOGRAPHY 

 
This project helps illustrate biological diversity at Yellowstone’s climate monitoring sites and 
correlate the presence of sentinel taxa - Carabid beetles, with their occurrence across a 5,000’ 
elevation gradient. Documenting invertebrate shifts over time provide a sensitive indicator to 
better understand how Yellowstone’s changing climates and influence park habitats and 
wildlife. The photos from this project allow for the accurate and timely identification of several 
insect taxa and demonstrate the beauty and complexity of Yellowstone’s charismatic micro 
fauna.  
 

Equipment 
• Camera: Canon EOS 5D Mark IV 
• Macro Lens: Canon MP-E 65mm (1-5x) 
• Macro Flash: Canon Twin Lite MT-26EX-RT 
• Stackshot Rail by Cognisys, Inc. 
• Zerene Stacker (Software, Build 1.04) 
• Canon ACK-E6 AC Adapter Kit 
• Slik AF2100 Single Action Head 
• Mounting platform 
• Four NiMH Batteries (with four alternates in charger) 
• Finnhomy Professional light box or foam cooler 
• Black Felt 

 
Our setup is pictured below. The doors on the 
front of the light box can be manipulated to allow 
more or less light to be reflected. To illuminate 
the box, flip the switch on the power chord. 
Adjust the brightness with the adjacent dimming 
knob. Be sure to turn the lights off with the switch 
when they are not necessary to prevent over-
heating. 
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Because of the high level of detail recorded, ensure specimens have been cleaned before 
photographing. The side of the specimen you wish to photograph dictates which method 
and setup procedures to follow. 
 
Front, side, and rear images are captured with a modeling clay base and the specimen mounted 
in the same manner they are stored, rotated as necessary, with the distant lightbox serving as 
backdrop. The mount rotates using the handles to the side and beneath the modeling clay base. 
Use these in conjunction with the Slik camera mount to determine the appropriate angle to 
photograph the specimen.  
 
Top and bottom photos are critical for diagnostic identification, but can be significantly more 
time and energy intensive. First, place the pin end into the small ball of modeling clay fixed to 
the mount. Determine the angle you would like to photograph the subject. Attach either black 
felt or a white piece of paper as close to the mount as possible by cutting a slit to the center of 
the felt or paper and sliding the mounted pin through the slit so that it rests behind the 
specimen. No two setups are quite alike (and white paper needs to be changed periodically as 
oils from the clay saturate the paper). You can continue to rotate the mount as necessary.  
 
Examples of these setups are shown below (Figure x). The photo on the left depicts the setup 
necessary for side or front (face) shots whereas the right photo shows how to photograph the 
specimen from the top. To photograph the bottom, the specimen will be mounted with the pin 
completely through the insect, so you would only need to flip the pin around and mount it to 
the clay from the other side.  
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CAMERA—COMPUTER INTERFACE 
Connect all cables to appropriate locations, including the USB cable from the camera 
directly to the computer. The cords are all labeled, but if further clarification is needed, use 
the list below to match the letter to the corresponding cord.   
A – These two cords connect the camera to a power source. The cords connect to each 
other and connect to the camera in the front on the right side.  
B – This connects the Stackshot Rail to a power source.  
C – This connects the Stackshot Rail to the camera. The port for this cord is on the front left 
side of the camera. 
D – There are two cords labeled D. One is white and is attached to the motorized 
mechanism that allows the camera to move forward and backward. This connects to the 
other cord labeled D and then to the Stackshot Rail. 
E – This is a USB connector that should go from the computer to the left side of the camera.  
 
Once powered on, a prompt will appear automatically for Canon EOS Utility (assuming its 
downloaded and installed). If it does not, open the program from the desktop or start 
menu.  
Select “Remote Shooting” to the following windows. The top right “EOS 5D Mark IV” will be 
the only window initially present.  
To activate all necessary options follow the steps labeled in the image above.  
1. Select “Live View shoot.” This will allow you to view the frame on your computer screen.  
2. Select the flash icon 
3. Double click “Flash Function Settings.” The window that appears will allow you to 
manipulate how long the flash is on. Make sure the flash is set to manual.  
 
Tip: If while you are shooting pictures, you notice that a number of the frames are black, 
abort the process on the Stackshot Rail and replace the batteries in the flash. The battery 
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compartment is located on the right side of the flash on top of the camera. The flash 
requires four AA batteries and sometimes need to be replaced once a day depending on 
how many photos are being taken and how long the flash is on when firing. 
 
4. Turn on depth of field preview to view the specimen in front of the lens. 
5. Change white balance from “auto” to “Flash” 
6. Change the destination folder by clicking on the small folder icon. This determines where the 
photos are stored. Under “DestinationFolder,” change the destination to:  
 
Genus_Species_YEAR(MONTH)DAY_CollectionLocation_Collector 
Ex: Coccinella_transversoguttata_2016JUN23_MtWashburn_Bowser 
 
File structure and organization are covered next in this document.  
 
TIP: Clicking on the folder location name next to the folder icon immediately brings you to 
that folder and your photos.  
 
7. This is where you will control your camera settings (aperture, ISO, and exposure). Details 
about these settings are included later in this document under the section titled “Camera 
Settings.”  
 
FILE STRUCTURE 
EOS Utility will automatically create the folder above if it does not exist. Created within is 

another folder populated with the cur- rent date– this is where your raw photographs will 

go. Within this folder, create new ones based on the angles you are photo- graphing (ex: 

“1-Front”, “2-Side”, “3-Bottom”, “4-Top” or “5-Top_2”, etc.). Drag completed series 

(carefully removing test shots) from the parent date folder into your labeled sub-folders. 

Within Windows Explorer, navigate to the parent folder for the specimen. Create a text file 

by right clicking anywhere -> New -> Text Document. Transcribe any tags associated with 

the specimen to this location. 

Once photos are stacked with Zerene Stacker, they are exported to the parent specimen folder 
in the format shown below (Figure x). 
 
 



 
 
 

72 

 

 
 

CAMERA SETTINGS  
 
Check all the camera joints to make sure they are 
tight. 
 
Below are some starting points for aperture, ISO 
and exposure time. These are flexible and should 
be manipulated as necessary to achieve the 
proper lighting for each specimen.  
 
Aperture: Primarily between f/5.6 and f/8 
Increasing this number decreases light but increase focus area. 
Keep aperture as high as possible to ensure highest level of focus.  
 
ISO: 100, 125, 160, 200, 250 
Sensitivity of the sensor to light. Higher numbers increase graininess 
 
Exposure time: Common values are 1/100, 1/125, 1/160, 1/200 

Speed of shutter actuation and resultant light allowed to expose. 

Epithe
t 

Date Locatio
n 

Collecto
r 

 

Stacked and Exported images go inside parent folder, with same naming mechanism plus 

Orienta- tion of the specimen and other pertinent notes (like stacking method and clarity, if 

necessary) 
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Keep shutter speed above 1/50 to avoid camera shake, above 
1/100 when possible.  

 
 Flash: Set to Manual  

Double check your settings to make sure they are correct between 
photo shoots. 

 
 Flash Time: Between 1/8th and 1/16 sec. 
Higher magnifications may require more light (1/4 sec) 
Experiment with these settings by taking several test photos of the specimen and assessing if 
the image after each photo to see if it needs more or less light. Look for an exposure that gets 
rid of most glaring white patches reflecting off the insect. (The photo may appear slightly darker 
than you think it should, but brightness can be adjusted post-processing in Adobe Photoshop.) 
Manipulate these settings and continue taking test shots and making adjustments until you are 
satisfied with the lighting on the specimen.  Once this is complete, you can set up the start and 
end points with the Stackshot Rail.  
 
STACKSHOT RAIL CONTROLS 
After the specimen is centered in front of the camera and a magnification has been set by 

rotating the lens barrel, all focusing should occur with 

the Stackshot and Rail combo.  “Fwd” and “Back” refer 

to the manual movement of the camera along the rail 

axis. Use this function when establishing a focus and 

framing the specimen.  All options on the Stackshot 

Control screen are navigated between with the “Select” 

button, followed by “Up” and “Down” to adjust selected 

parameters. 

1) Start by selecting the MODE and using Up/Down to 

navigate to: Auto-Dist (this is the only mode utilized 

in this guide) 

2) “Select” down to Dist/Step. This option controls the 

distance (in microns) the camera will move between each image to create our stacked 

photos. Refer to the guide to the right, based upon the magnification level indicated on the 

top of the macro lens barrel. 

*Larger Apertures will increase depth-of-field and decrease the movement needed between 

images— this will require experimentation. 

3) Now “Select” down to “Select Start Pos” and use the Forward/Back buttons to locate the 

point you would like the rail to begin photographing. Press Up to set this point, then use 

Forward/Back again to find the end of the photographed range. 

*It is advisable to set the Start and End points just beyond the final point you would like in focus. 

Magnification Distance Camera 

is Moved 

(microns) 
1X 600 

1.5X 325 

2X 230 

2.5X 165 

3X 135 

3.5X 115 

4X  90 

4.5X 75 

5X 65 
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Once both are set the option “Press Up/Down to Start” will appear. Once completed, “Select” 
down to Change Settings for a new setup run. 
 
STACKING IN ZERENE 
 

Once a series of photos have been taken, ensure they are 

placed in a correspondingly labeled folder (ex: “3-Side”). With 

this folder still open, start the Zerene Stacker software.   

Drag the collection of photos to the left hand column.  
Next, on the top menu bar click Stack -> Align and Stack All 

 
Pmax– Good at finding and preserving detail and at handling overlapping structures like 
mats of hair and criss- crossing bristles. But PMax tends to increase noise and contrast, and 
it can alter colors somewhat. Images can appear dark or overblown. 
Dmax- “depth map” method. It does a better job keeping the original smoothness and 
colors, but it's not as good at finding and preserving detail.  Sometimes blurry artifacts 
occur.  
Both– (preferred) running both will greatly increase processing time, but provide two 
potential outputs that can be conjunctionally Retouched to create one clear picture. 

 
*When running Dmax select the highest % that makes the background black without 
black appearing on the insect, this will help reduces swirls around the edges of the 
insect. 

 
Once the photos have been stacked retouch the images with the Zerene Stacker software. 
(This can only be done at after stacking the photos, you cannot retouch a photo later.) Blurry 
bristles or transparent appendages (from overlap, typically) can be addressed using 
Retouching mode. First, Save your stacked image(s). Next, select the stacked image you want 
to retouch and go to Edit -> Retouch. Find the layer where the part of the bug you are editing 
is in focus and use the brush to retouch the stacked image.  
 
*It can be helpful to start with the layers furthest away and move up through the nearest 
layers when retouching.  
 
Important functions to know: Left clicking and dragging over an area will copy from the 
selected layer to the stacked layer. The mouse scroll wheel changes the size of the editing 
brush. Spacebar + left click will pan the image. Spacebar + scroll wheel will zoom the image. 
S-key + scroll wheel will scroll between the different layers. 
 
For an in depth presentation of these processes its best to watch an 8 minute video on 
Zerene’s website: 
https://zerenesystems.com/cms/stacker/docs/videotutorials/retouching001/index (also on 
Thorax Hard Drive\Documents)  

https://zerenesystems.com/cms/stacker/docs/videotutorials/retouching001/index
https://zerenesystems.com/cms/stacker/docs/videotutorials/retouching001/index
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Once the processing and retouching are complete, highlight the desired final product 
under the “Output Images” box in the lower left. Navigate to File -> Save Output Image 
 
Save the image in the specified format (example below) and choose JPEG at Quality 10. 
(Ex:        Coccinella_transversoguttata_2016JUN23_MtWashburn_Bowser_BOTTOM_PMax) 
 
*ALWAYS SAVE WORKING IMAGES AS COPIES. SELECT “SAVE AS” AND ADD THE APPROPRIATE 

VERSION NAME TO THE IMAGE NAME* 
If the license for Zerene Stacker expires, enter this license key into the space provided: 

 
==== BEGIN LICENSE KEY ==== Copyright 2019 Zerene Systems LLC, all rights reserved. This key 
is unique -- do not redistribute. Licensed To: YCR Software Name: Zerene Stacker 1.0 Licensed 
Versions: through 1.99 License Type: Personal Edition Payment ID: ZER190320-8399-54103 
Issue Date: Wed, 20 Mar 2019 14:37:55 -0700 License Signature: 
c49603679ea7d7239e7d13042b49f8c528296b9793aec4 
ae5b41031e862fc2237c63d04fc5235eb0718a71971564 
195c85883982dcfdd85d27c255a237d0ced2b18416573e 
e01e35e7beb9ee52c33f57d4129911cb62e80a279115b1 
7abbe51c02b7957412727dfe59dda62e188082ef0cb0d4 fc614de14863d2180fdeb27a51 ==== 
END LICENSE KEY ==== 
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PHOTO EDITING 
 
PHOTOSHOP 
Adobe Photoshop is used for editing out pins and removal of debris. First, make a copy of your 

image by right clicking the “background” layer in your layers table and selecting “duplicate 

layer.” Now you can begin retouching your photo. You will always want to make edits on the 

“background copy.” There are myriad methods for removing and altering photographs. The 

tools listed below are primarily used for cleaning up the photo.  

(All tool sizes can be adjusted using the bracket keys on your keyboard) 
 

Begin by opening Adobe Photoshop from the Start menu. Bring a photo into the 
program by clicking and dragging it from its folder on the external hard drive.  
 
It can be helpful to give the image some contrast. To do this, select “Image” on the 
toolbar and click “auto contrast.” This can also been done manually by navigating to 
the “adjustments” tab located in the menu on the right side of the page.  

 
Crop – Resize your image and place the specimen in the center of the frame. This 

will also allow you to rotate the image if the specimen is not level.  
  
Spot Healing Brush Tool—Designed to automatically detect and replace selected 

areas with imagery from the sur- rounding area, and then blend. Very useful for 
small grains of dirt, and other debris. 

Clone Stamp Tool—Similar to Spot Healing but allows the user to select the source 
material for fill. This tool also doesn’t blend with surrounding imagery. Useful for 
removing the mounting pin with surrounding white/black. 

 

Sharpen – Bring definition to edges that became fuzzy when using the clone stamp. 

This can also help sharpen images taken at a high magnification. 

 
Dodge/Burn Tools—Use to increase or decrease exposure in selected areas. (Right 

click tool to toggle between) 
 

Zoom – Use to zoom in and out of the image.  
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Basic editing of Diagnostic photos: 

1) Crop the image 

2) Select Image -> Curves (Ctrl+M) – drag the upper corner box along the top edge to lighten 

the image and the lower corner box along the bottom edge to darken the image (saturate 

it with more color—only requires a minimal adjustment if any) 

3) Select Image -> Shadows/Highlights – Take shadows down to 0% initially, Adjust Highlights 

%, Adjust Shadows % if it helps clarify image 

4) Select Image ->  Levels (Ctrl+L) – Use the three arrows to adjust light levels within the 

image 

5) Select Image -> Brightness/Contrast – Adjust levels for best image 

6) Save Image in A:\Macro Insect Photos file with _final at end of file name 

7) If background seems patchy use the Spot Healing Brush or Patch Tool (under the Spot 

Healing tab) to smooth out background. If satisfied with edits Save image again.  

  

Masking – for Artistic Photos 

You will use masks to create an even background for the image. Once you have cleaned the 

specimen with photoshop, you can begin masking out the subject. Start by selecting the “quick 

selection tool” (fourth from the top of your vertical toolbar on the left side of the page.) There 

are a number of options to select your subject, but I’ve found that clicking “select subject” 

from your toolbar at the top of your screen is the most effective. You can alter the automatic 

selection by clicking and dragging the selection to incorporate more of the subject or by 

pressing alt on your keyboard and clicking to remove objects from the mask. Once you’ve 

selected your subject, create a mask by selecting the vector mask in the layers toolbar. This is 

the white rectangle with a hollow, grey circle inside it. De-select your original background 

image by clicking on the eye located next to the layer. You will now be able to continue editing 

your mask. Use the paintbrush tool to continue painting over the background of the image, 

thus removing it. Try to remove as much of the background as possible, but it is okay if you 

cannot remove all of the background from areas closest to the specimen, as we will use 

another tool to do that next. Once you’ve removed as much of the background as you can, 

double click on the “background copy” mask and select the “refine edge brush” tool. This is the 

second one from the top of your left toolbar. This tool will allow you to paint closer to the 

specimen and paint over hairs without masking them out with the background. Be careful to 

only use the edge of this tool. You do not want to paint directly over the main body of the 

specimen or you may accidentally remove parts of the subject. If this does happen, you can 

remove it by pressing alt on your keyboard and painting back over it. It can take a moment for 

photoshop to catch up with your brush strokes, so take a moment to pause between clicks to 

evaluate what you’ve done. Once you’ve refined the edges around your specimen, click “OK” 
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on the bottom right corner of the screen. From here, you can fill in the background with a solid 

color. Select the tile for your original background copy (not the mask,) and navigate to the icon 

in your layers tools that shows a circle that is half white and half gray. Click this and select 

“solid color.” The window that appears will allow you to select a color. You will likely only use 

white and black. Be sure that you’ve selected true white or true black by selecting a color from 

the absolute corner of the “color picker” square and click okay. Next, drag the new “color fill” 

layer so that it appears in your layers list beneath your background copy/masked layer. Your 

mask should now appear with a completely uniform background.  

 

Next, you can alter the color vibrancy or contrast of your photo by working under the 

“adjustments” tab on the right side of your page beneath your layers. You don’t want to alter 

the colors too much, because the image needs to remain true to what we would see in nature, 

but this can help to bring colors back that may have gotten dull with the flash from the 

camera. I have found the most useful adjustment to be the “vibrance” tool, which is pictured 

as an upside-down triangle. Any changes you make in the adjustments tab are added as layers, 

so you will need to edit them from within their respective layer. These changes can also easily 

be deleted, so feel free to play with them. 

 

Lastly, press ctrl + alt + shift + E on your keyboard to flatten all of your layers and make a copy. 

Now we will sharpen the image. Note that this is not always necessary, but can really help to 

bring out details in your image. Navigate to the toolbar on the top of your page and select 

“filter.” From this drop down menu, navigate to “other” and select “high pass.” The radius 

should be set to a very low number of pixels – I would suggest staying below 2.5. Click OK and 

then navigate to the dropdown menu in your layers tab. Change the menu that reads “normal” 

to “overlay.” Your image should now appear sharper.  

 

Once you are satisfied with the image, save the finished product as a copy with the same 

naming format, followed by the word “edited” to show that the image is done being 

retouched. Again, always select “save as.” 

 

 
TEXT FILES 
Each image must be associated with its corresponding metadata. Create a text file under 
the same name as the folder for the designated specimen and write in the following 
information in this format: 
 
Long-horned beetle - Acmaeops pratensis 
Photo by: NPS 
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Collected by: D. Azevedo 
Park County, WY 
June 23, 2016 
Mount Washburn N1 
Determined by: G. Bowser 

 
This information can be found on the tag that corresponds to the specimen. Make sure the 
tag always stays with the insect.  
 
Create a folder for each specimen in the following location: P:\Strategic 
Communications\Macro photos 
 
Transfer the final photo product and the text file into the corresponding folder. This is 
where they need to be in order to be uploaded to the park Flickr page.  
 
 
 

View macrophotography images of Yellowstone insects here: 
https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434 

 
 

https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434
https://www.flickr.com/photos/yellowstonenps/albums/72157704843714434
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YELLOWSTONE SCIENCE ARTICLE 
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YELLOWSTONE FOREVER ARTICLE 
 

 

CITIZEN SCIENCE PARTICIPANTS IN ACTION 
• NOVEMBER 28, 2018 
• INSIDE YELLOWSTONE, YELLOWSTONE QUARTERLY 

BY CHELSEA DEWEESE 
 

The buzz of grasshoppers fills the 
sagebrush-scented air atop an open 
hillside in Yellowstone National Park’s 
northern range when Dani Hatfield breaks 
her silence. “Wow. There’s some cool stuff 
in here,” she says, looking into a plastic 
container filled with insects suspended in 
cloudy liquid. “It keeps changing every 
time. That’s my favorite part.” The 
number of millipedes captured in this 
particular “pitfall”—a plastic container 
placed in the ground that bugs crawl 
into—is more than last month’s capture, she continues. Hatfield, a 19-year-old from nearby 
Gardiner, Montana, studies filmmaking and entomology at Montana State University in 
Bozeman and has volunteered with the 
National Park Service (NPS) since high 
school. This project isn’t necessarily tied to 
what she studies in school though, she 
says: “I just like bugs. So I volunteered.” 
Nearby, Hatfield’s teammate, Maureen 
Cairns, documents plants growing in plots 
adjacent to field equipment gathering 
temperatures, precipitation, wildlife 
sounds, and other data. 
 
Hatfield, Cairns, and their other teammate, 
Gabrielle Blanchette, were three of nearly a dozen volunteers gathering data for Yellowstone 
National Park that afternoon as part of the joint Yellowstone Center for Resources and 

https://www.yellowstone.org/citizen-science-participants/
https://www.yellowstone.org/citizen-science-participants/
https://www.yellowstone.org/category/inside-yellowstone/
https://www.yellowstone.org/category/inside-yellowstone/
https://ys-wp-media.s3.amazonaws.com/wp-content/uploads/2018/12/YF_CitizenSciencePhenology_Mammoth_SEP18_LudinMatt_01.jpg
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Yellowstone Forever Citizen Science Initiative, a cooperative effort between Yellowstone 
Forever and Yellowstone National Park biologists. Citizen science allows volunteers to 
participate in scientific undertakings to further their appreciation of Yellowstone, and it also 
helps the park achieve more research than current funding and staffing may allow. 
 
Since its inception more than 10 years ago, 
citizen science has been a resounding 
success, and Yellowstone Forever is now 
working to create more opportunities and 
fold them into existing programs. The 
Yellowstone Phenology Project, described 
above, is the study of plant and animal life-
cycle changes over time. Other citizen 
science projects include red-tailed hawk 
nest monitoring, invasive weeds mapping, 
and northern range ungulate research. Erik 
Oberg, a biologist with NPS and the lead 
on the phenology project, described the volunteer help to his project as “invaluable.” It’s the 
perfect hands-on opportunity for volunteers and a chance to recruit, train, and retain volunteer 
staff, he says. 
 
The volunteers run the gamut. Some, like Blanchette, who is an entomology graduate student 
at MSU Bozeman, use it for professional development. Some, like Cairns, see it as a way to get 
outside and away from the desk while continuing to learn about Yellowstone. Retired 
entomology professor Bob Stoltz lends his expertise identifying bugs captured in the pitfalls. 
And Jana Paus, of Bonn, Germany, finds it a way to make friends and stay occupied while she 
visits her boyfriend for the summer while he’s working in Yellowstone. All find fun in the 
camaraderie of collecting and sorting data. “I always thought I’d like to do volunteering,” says 
Paus, who recently earned her undergraduate degree in biology and is enrolling in a master’s 
program. 
 
The morning after collecting insects and 
plant data in the field, volunteers gather in 
a classroom at the Yellowstone Forever 
building in Gardiner, Montana, to carefully 
extract insects from the pitfall samples, 
examine them under a microscope, and 
sort them into vials filled with ethanol. 
These samples will be made available to 
permitted researchers, including graduate 
students, and will be stored in a repository 
at the Yellowstone Heritage and Research Center for future study. Some, like the carabid 
ground beetle, of primary interest in the insect portion of the phenology study, will be sent to 
outside experts for further classification. Beetle species trends can be a key indicator of climate 
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change, Oberg says. The study is being conducted in a way that data can be shared with the 
National Ecological Observatory Network, which is in the process of finalizing a field site in 
Yellowstone. Plant information will illustrate what plants are growing, flowering, and seeding at 
certain times of the year.  In terms of what the data will be used for: “We are documenting 
what is happening in Yellowstone at this moment in time at different elevations,” Oberg says. 
This can be incorporated into future studies. 
 
Joshua Theurer, citizen science program 
manager at Yellowstone Forever, says 
visitors benefit greatly from participation in 
citizen science because it allows them to 
“peek behind the perceived veil of science” 
and have a more in-depth visitor experience. 
He says Yellowstone Forever is working to 
include more youth—from middle school to 
college-aged—in volunteer roles. “The hope 
is that these projects are not just a nice, 
isolated experience but will inspire continual 
engagement with projects in participants’ 
local areas,” he says. Yellowstone Forever is working on ways for students to remain involved 
remotely both before and after their visit. 
 
For volunteers Brian and Sydney Wallace of Bozeman, the benefits of volunteering are more 
visceral. Sydney says focusing on something so small, like a collection of insects, allows her to 
think about the park in an entirely different context, instead of focusing only on big things like 
bears, and wolves, and mountains. Plus, “It was a lot of fun!” For Bryan, it was reassuring to 
know somebody’s paying attention to Yellowstone’s smaller details, and he was happy to 
contribute. “It’s an investment of a day,” he says. “Who doesn’t have a day to invest?” 

For information on participating in the phenology project, please email Erik Oberg directly at 
erik_oberg@nps.gov.  Learn more about the Citizen Science Initiative here. 
 
This article was originally published in the Winter 2018 issue of Yellowstone Quarterly. 
Photos by YF/Maria Bisso and YF/Matt Ludin 
 
 
https://www.yellowstone.org/citizen-science-participants/ 
 
 

https://www.yellowstone.org/experience/citizen-science/
https://www.yellowstone.org/experience/citizen-science/
https://www.yellowstone.org/yellowstone-quarterly/
https://www.yellowstone.org/yellowstone-quarterly/
https://www.yellowstone.org/citizen-science-participants/
https://www.yellowstone.org/citizen-science-participants/
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NEON BLOG POST 
 
Citizen Scientists Extend Beetle Research at Yellowstone 
 
What can a ground beetle tell us about the environment? Quite a lot! This diverse and 
ubiquitous family of insects provides a window into environmental health and change. 
 
Erik Oberg, a biologist at Yellowstone National Park, is leading an ambitious beetle-
biodiversity initiative on the Northern Range of the park. The Yellowstone Phenology 
Project collects data on Carabid beetles and other environmental indicators at seven sites 
across a 4,000+' elevation gradient. Erik has recruited a cadre of citizen scientists to 
collect, classify and count beetles collected at the sites. 
 
Counting the Carabids 
Carabids, or ground beetles, are a diverse family of insects found in nearly every 
terrestrial ecosystem on earth, with 40,000 species identified worldwide and more than 
4,000 in North America. Many species are carnivorous, sitting at the top of the 
invertebrate food chain. Studying Carabid diversity, abundance and range may provide 
insights into what is happening with the invertebrate species they prey on as well as the 
numerous bird and small mammal species that rely on them for food. Because insects have 
short life spans, they are also highly sensitive indicators of environmental change. 
 
Carabids have the advantage of being fairly easy to capture and count (though with so 
many similar species, accurate species identification can be challenging). Erik and his team 
collect the beetles in pitfall traps using the same collection protocols developed for use at 
NEON’s terrestrial field sites. 
 
The Yellowstone Phenology Project (YPP) began the beetle inventory in 2018 and will 
continue through 2019 and 2020. The three-year study will provide baseline data on 
Carabid diversity and abundance across the elevation gradient in Yellowstone's Northern 
Range that will be invaluable for future researchers. "We're not drawing any conclusions 
with these data," Erik explains. "What we are doing is establishing a baseline that will 
allow future researchers to assess how beetle populations are changing over time. For 
example, are new species of beetles moving in at lower elevations? Are species now 
present mainly at higher elevations leaving the park?" 
 
The seven sites are located along an elevation gradient that begins in Gardiner Basin 
(5,300’) and ends at the peak of Mt. Washburn (9,600'), rising over 4,000 feet along the 
way. The sites were originally established by Yellowstone GIS Specialist Ann Rodman in 
2010 as part of a pollinator study. At the time, NEON was nearing the end of its design 
phase. Ann chose these study locations with the vision that when NEON field sites 
completed construction, the study locations would bracket a planned NEON field site. The 
sites now function as climate change indicator sites for Yellowstone, with a broad range of 
sensors and data collection efforts aimed at monitoring key indicators of climate change 
such as temperature, soil moisture and snow depth. NEON's Yellowstone Northern Range 
(YELL field site) sits near the midpoint of these sites as part of NEON’s D12: Northern 
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Rockies ecoclimatic domain. 
 
Partnering with the NEON Program 
Erik collaborated with Ann to build on her vision by adding Carabid data to the other data 
that are collected at the indicator sites. Because the team uses NEON's beetle collection 
protocols, data will be comparable between YELL and the YPP sites located up and down 
the elevation gradient. The project gives park managers and researchers an exciting 
opportunity to compare Carabid distribution and abundance paired with meteorological 
data at different elevations and see how beetle communities are changing across the 
gradient over time. 
 
Erik reached out to the NEON science team during the planning phase of his project. He 
has a long connection with the NEON program and was part of a team instrumental to 
finalizing the NEON permit and application to conduct research inside Yellowstone 
National Park. Once YELL was established, he saw an opportunity to build on NEON's 
research by using their protocols across a broader cross section of the park. "We wanted 
to make sure that data we are collecting are accurate and comparable. The NEON 
protocols are scientifically valid and were easy to implement with our volunteers." 
 
The NEON program provided training resources and guidance to the YPP team. In addition 
to using the same pitfall trap design, YPP used a stratified random spatial design to select 
the collection plots within each site. This method, also used by NEON, ensures that human 
bias does not influence plot selection and results in samples that are more representative 
of the habitats found within each site. 
 
Interested in implementing NEON's data collection methods? Contact Us with your ideas! 
 
Katie LeVan, a Research Scientist for the NEON program specializing in insect ecology and 
data, says, "This was a very collaborative process between NEON and the Yellowstone 
team. Erik reached out to us to see how his research questions and interests fit into what 
NEON was already doing in Yellowstone. We were able to support him with the sampling 
design so he can use the NEON protocols with very minimal modifications. His work 
represents a deep dive into Carabid populations in the park that goes beyond what we are 
able to do with a single site." 
 
The Power of Citizen Science 
As valuable as the Carabid data will be for the scientific community, the project would 
never have gotten off the ground without the hard work of Erik's team of citizen scientists. 
In 2018, "Carabid Crew" volunteers put in more than 1,340 hours of effort to collect 
beetles from the pitfall traps and sort, pin, label and catalog more than 3,900 specimens. 
Undergraduates and graduate students from seven different universities participated. Two 
volunteers in Louisiana dedicated hundreds of hours to mounting and cataloging 
specimens. In addition to collecting beetles, field volunteers also recorded plant phenology 
observations (the timing of events such as leafing, flowering and leaf drop). 
 
Erik says, "It would be impossible to do this project without our volunteers.  I don't have a 
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line item in my budget for Carabid collection. We are lucky to have a team that is very 
dedicated and excited to be bringing new knowledge to science through their efforts. It's 
impossible to have a bad attitude at work when working with our volunteers." 
 
Engaging the general public in science is an important part of the missions for both 
Yellowstone and the NEON program. Erik says, "We need this research to inform 
management decisions, but we also want people to understand why we are doing it. Our 
citizen science programs get people engaged and foster increased scientific literacy and 
support for park stewardship." 
 
Katie says, "It's exciting to see so many people now engaged with science through projects 
like Erik's or through apps like iNaturalist or eBird. Of course, when working with 
untrained non-scientists we always have to consider the accuracy and reliability of the 
data. But in many cases, the data being generated by citizen scientists has proven to be 
highly reliable. Participants are adding incredibly valuable data that the scientific 
community would not be able to collect otherwise, especially when it comes to things like 
species distribution." 
 
The Carabid Crew is now engaged in data collection for the 2019 field surveys. The 2019 
team has grown to 37 volunteers ranging from ages 8 (the son of another park ranger) to 
77 (a retired laboratory assistant). 
 
Over the winter, teams will count and catalog the species collected. A contract 
entomologist will check their work and identify Carabids to species. Volunteers are also 
starting to take a look at the bycatch (non-Carabid invertebrates caught in the pitfall 
traps). One student at Montana State University, Bozeman is cataloging ant species 
collected at the sites. This year, volunteers began capturing high-definition images of 
Carabids using a macrophotography studio set up by the Canon Foundation. The stunning 
images are publicly available on Flickr. 
 
Katie says, "This is exactly the kind of collaboration I would like to see more of as the 
NEON program matures. We have a lot of resources available for researchers that they can 
leverage for their own projects and interests. Our infrastructure, samples, data and 
protocols are available to support a broad range of research initiatives." 
 
The Yellowstone Phenology Project will continue at least through 2020. 
 
https://www.neonscience.org/observatory/observatory-blog/citizen-scientists-extend-
beetle- research-yellowstone 
 
  
   

    
 

https://www.neonscience.org/observatory/observatory-blog/citizen-scientists-extend-beetle-research-yellowstone
https://www.neonscience.org/observatory/observatory-blog/citizen-scientists-extend-beetle-research-yellowstone
https://www.neonscience.org/observatory/observatory-blog/citizen-scientists-extend-beetle-research-yellowstone
https://www.neonscience.org/observatory/observatory-blog/citizen-scientists-extend-beetle-research-yellowstone
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PARAMOUNT STUDIOS DOCUMENTARY AND ARTICLE 
 
Paramount Studios short documentary and article 
link 1 https://www.youtube.com/watch?v=F9ovWx3sul8  

link 2 https://popculture.com/tv-shows/2019/08/13/yellowstone-ian-bohen-paramount-network-

save-yellowstone-national-park/ 

 
 

https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DF9ovWx3sul8&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=4bIY3bK7mBh0YQ01cO55wed%2BE0Bd1KfOSagTFpzDiBI%3D&reserved=0
https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DF9ovWx3sul8&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=4bIY3bK7mBh0YQ01cO55wed%2BE0Bd1KfOSagTFpzDiBI%3D&reserved=0
https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fpopculture.com%2Ftv-shows%2F2019%2F08%2F13%2Fyellowstone-ian-bohen-paramount-network-save-yellowstone-national-park%2F&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=vm9c2wriP8UPJi6gBORiI3WZmrSZbfox2zodZLWCwKI%3D&reserved=0
https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fpopculture.com%2Ftv-shows%2F2019%2F08%2F13%2Fyellowstone-ian-bohen-paramount-network-save-yellowstone-national-park%2F&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=vm9c2wriP8UPJi6gBORiI3WZmrSZbfox2zodZLWCwKI%3D&reserved=0
https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fpopculture.com%2Ftv-shows%2F2019%2F08%2F13%2Fyellowstone-ian-bohen-paramount-network-save-yellowstone-national-park%2F&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=vm9c2wriP8UPJi6gBORiI3WZmrSZbfox2zodZLWCwKI%3D&reserved=0
https://nam02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fpopculture.com%2Ftv-shows%2F2019%2F08%2F13%2Fyellowstone-ian-bohen-paramount-network-save-yellowstone-national-park%2F&data=01%7C01%7CWCarr%40yellowstone.org%7C24044c2600cd4b90373d08d720f06ba9%7Cc8beb46f1360493795b135169b23a672%7C0&sdata=vm9c2wriP8UPJi6gBORiI3WZmrSZbfox2zodZLWCwKI%3D&reserved=0
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CITIZEN SCIENCE ANNUAL REPORT 
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SITE MAPS 
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PERSONAL CHECKLIST FOR PHENOLOGY FIELD DAY 

 
1. Volunteer Shirt 

2. Layered clothing (for changes in temp) 

3. Extra socks 

4. Jackets: waterproof, lightweight and warmer 

5. Waterproof pants 

6. Gloves, hat for sun and/or cold 

7. Water (hydropacks are easiest)   

8. Small backpack for waterproof clothing, lunch, snacks and personal first aid…i.e. 

medications, Benedryl spray, children’s dose tabs, bug spray, sunscreen) 

9. Small front carrying fanny pack to hold bear spray and small notebook and pencil for 

anything in the field needed to be noted.  Also good idea to have energy bar or nuts 

easily accessible. 

10. Phone and car charger 

11. Hiking poles if you use them 

12. Sturdy hiking boots 

13. Lunch, snacks 

14. Money for incidentals if needed. 
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FIELD KIT CHECKLIST 
 
Dry Side 

 Binder (1) 

 Measuring tape (1) 

 Compass (1) 

 GPS unit (1) 

 Whirl Packs (30) 

 Filter fabric (30) 

 Gloves (4 pairs)  

 Large Ziploc bags (3) 

 Binder clips (30) 

 First-aid kit 

 Zip ties (6) 

 Replacement spacers (6)  

 AA Batteries (4) 

 Extra Pitfall cups (2) 

 Scissors (1) 

 Permanent markers (2) 

 Pitfall Labels  

Wet Side 
 Ethanol squirt bottle (1) 

 Refill Glycol bottle (1) 

 Hammer (1) 

 Trowel (1) 

 Strainer (1) 

 Wipe cloth (1) 

 Knee pad (1) 

 Stakes (2) 

 Pitfall cups (2)  Note: There should be 4 total cups, 2 on wet side and 2 on dry side 

Additional Supplies 
 Discard bottle (1) 

 Daub frame (1) 

 Ethanol refill can (1) 

 Extra Glycol bottle (1) 

 Pin flags (3) 

Please be sure to check all equipment is packed prior to heading out to your site and once again 

upon returning from the field. 


